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Banner Navigational Training - Tennessee State …



Banner Navigation And Course Schedule Training Records and Registration Office of Enrollment Management 2 What is Banner ? Banner Student brings together administrative and academic functions to make it easier to manage data while giving students and faculty secure online access to the information they need. This is a product of SunGard Higher Education It may be accessed two different ways. INB Internet Native Banner is the database where student information is entered. SSB Self Service Banner (myTSU) used by students, advisors, staff, and faculty. Changes made in myTSU update INB and vice-versa. Internet Explorer will be the browser of choice at TSU. Information from Banner Student Training documents and resources has been extracted in an effort to offer a concise overview of navigating in Banner3 Logging into Internet Native Banner (INB) Access TSU homepage Go to: This is the login menu.
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    	Transcription of Banner Navigational Training - Tennessee State …


        
    	1 Banner Navigation And Course Schedule Training Records and Registration Office of Enrollment Management 2 What is Banner ? Banner Student brings together administrative and academic functions to make it easier to manage data while giving students and faculty secure online access to the information they need. This is a product of SunGard Higher Education It may be accessed two different ways. INB Internet Native Banner is the database where student information is entered. SSB Self Service Banner (myTSU) used by students, advisors, staff, and faculty. Changes made in myTSU update INB and vice-versa. Internet Explorer will be the browser of choice at TSU. Information from Banner Student Training documents and resources has been extracted in an effort to offer a concise overview of navigating in Banner3 Logging into Internet Native Banner (INB) Access TSU homepage Go to: This is the login menu.
2 You must select the correct Banner database to login successfully. Instructions on how to log into Banner will be given by your instructor. This is the Login menu: Click on PROD System 4 This is the logon dialog box. Enter the username and password given by your instructor. Click on Connect. 5 Menu The Main Menu provides an overview of the menus, forms, and jobs on Banner . Use the Main Menu to navigate through Banner . Menu Part Description Menu Bar Offers a variety of options for navigating within Banner . Object Search Access a form, job, or Quick Flow if you know part of its name, Description or type. Toolbar Set of icons that represent shortcuts for performing common functions From the main menu Auto Hint/Status Describes the Field where the cursor is located Line Displays error and processing Messages Explains the purpose of the field, what can be done next or how to Access another window or form Hierarchical Tree Access forms through the main menu hierarchical tree Menu Structure structure 6 Menus - How to Access Forms 1.
3 Hierarchical menu 2. Go Field from Main Menu 3. Go Field accessed by <F5> function from a form 4. Options Menu from within a form 5. List of forms accessed during current Banner Session stored in the File Menu 6. Direct Access Form 7. Site Map Hierarchical Menu When accessing forms from the Main Menu they are displayed as a hierarchy. You can expand and collapse content by clicking on the folders. If you do not have permission to access certain forms on a product menu then you will not see those forms. Therefore, you will only see the product menu and the submenus under it. 1. Find the product area that you wish to access 2. Double click on the closed folder next to the product to expand the menu 3. Double click the form you would like to access or expand an area further by clicking the closed folder 7 Main Menu Go Field or File/Direct Access You can access a form from the Go field from the Main Menu, if you know the 7-character code of the form you wish to access.
4 You may also use the up and down arrow keys in the Go field to access forms you have previously opened during your current Banner session. Another option is to select Direct Access from the file menu. What is a form? A form is an online document where you can enter and look up information in your database. It is comparable to a screen in SIS+. 8 Parts of a form Part Description Title Bar May display the form s descriptive name, the seven-character ID name, the software version number and the database name. Search Icon Calls up the set-up form that contains the pre-entered data for you to select an ID. Key Block Contains information that determines what is entered or displayed on the remainder of the form. Information Block Displays data about the information entered in the Key Block.
5 Area where you enter information prior to updating a record. Field Area on a form where you can enter, query, change, and display specific information. Pull-down List Used to select a field value from a list of pre-defined values. A down arrow in the right side of the field indicates that the field has a pull-down list. Tabs Tabs are used to arrange information in a meaningful way, and allow you to navigate easily between groups or blocks of information. Title Bar Field Search Icon Information Block Pull-down list 9 What does the form name mean? Every form has an abbreviated 7 character form name. Most of the time, forms are referred to by this 7 character form name. Position 1 Identifies the Banner product owning the form, report, process or table. o G = General o S = Student Position 2 Identifies the application module owning the form, report, process or table.
6 Is unique to the product identified in position 1 o G = General E = Event Management J = Job Submission L = Letter Generation O= Overall P = Purge S = Security T = Validation form/table U = Utility o S = Student A = Admissions C = Catalog E = Support Services F = Registration/Fee Assessment G = General Student H = Grades/Academic History I = Faculty Load L = Location Management M = CAPP O= Overall P = Person R = Recruiting S = Schedule T = Validation form/table Position 3 Identifies the type of form, report, process or table. o A = Application o B = Base Table o I Inquire o P = Process o R Rule Table, Repeating Table, Report or Process o V = Validation o M = Maintenance Position 4, 5, 6, 7 Identifies a unique four-character code for the form, report, process or table.
7 O **IDEN = Identification o **PINC = Position Incumbent o **STDN = Student Relation o **PERS = Person 10 Form Components All Banner Forms are made up of three components: Records, Fields, and Blocks. A block is a section of a form or window that contains related information. If a form or window contains more than one block, each block (except the key block) may be enclosed in a beveled box. There are two types of blocks, a Key Block and an Information Block. Key Block o Where you start on a form o Every form has a Key Block o A unique code is entered such as an ID number, term code or document number. o Lets Banner know what piece of information you want to retrieve o The rest of the information on the form will refer to the information that you enter on the Key Block. Information Block o Section that contains related information to what was entered in the Key block o A line may separate each Information block on the form The Record Counter displays number of records viewed and the number of total records.
8 A question mark in the status line signifies that there are more records, but you haven t gotten to the last one, so the computer doesn t know how many there are Block Previous Block 11 Wildcards (Searching for items in a database) A wildcard is a special character that represents one or more other characters. Use wildcard symbols % and _ in the search criteria. % (percent sign) represents any number of characters _ (underscore) represents one occurrence of a character ma is used as an example. The wildcard symbols can be used with any combination of latter in any order. To get these Enter these All entries that contain ma %ma% All entries that begin with ma ma% All entries that end with ma %ma All entries that have m as a second character _m% Options Menu Forms can also be accessed from the Options Menu within a form.
9 When you are in most forms Banner lists related forms in the Options Menu. You may access these forms by choosing them from the Options Menu and when you close out of the chosen form you will be taken back to the original, or calling form. 12 Setting up My Banner The following forms are used to create, change and copy My Banner . Form Code Purpose Personal Menu Maintenance GUAPMNU Create and change your personal menu Personal Menu Maintenance Menu and Copy GUTPMNU Copy your personal menu to or from another user Menu Bar Overview The menu bar is located at the top of the menu on all forms. It offers a variety of options for navigating within Banner . The menu bar is accessible anytime except when a dialog box, alert box, or list of values (LOV) is displayed on the screen The menu bar consists of several pull-down menus 13 Pull-Down Menus There are nine pull-down menus on the menu bar, each with a variety of selections.
10 A dimmed option on a pull-down menu means that the option is disabled. File Menu Option Toolbar Icon Keyboard Shortcut Purpose Direct Access F5 Accesses the Direct Access From GUAPARM Object Search Accesses the Ojbect Search Form GUIOBJS to locate a form, job, or Quick Flow if you know part of its name, description, or type Quick Flow Displays the Quick Flow Form (GUAQFLW) which is used to access a Quick Flow Select Shift-F3 Returns you to the calling form and enters the selected value into the field that called the form Rollback Shift-F7 Action depends on what type of form is currently used. Form Action Application and Inquiry Clears all information (except Key information) and returns you to the first enterable field in the Key Block Validation Returns you to the first enterable filed on the form Query Returns you to the first enterable filed on the calling form Save F10 Saves all changes entered since the last time you saved Refresh Clears the message line; redraws the screen Print Prints the current window; inputs the date and time in the title bar Exit Actions vary.
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			Log In to myTSU with your TSU Username and Password https://mytsu.tnstate.edu/cp/home/displaylogin Click the “Banner Services” Tab followed by a click on the ...

			   Tnstate, Mytsu, Log in to mytsu

		

	

	
				
					

		
			ACADEMIC CALENDAR 2017-2018

			www.tnstate.edu
			ACADEMIC CALENDAR 2017-2018 FALL SEMESTER 2017 Aug 11 Faculty contracts begin Aug 11 Faculty report for fall semester activities Aug 14-15 Faculty/ Staff Institute

			   2017, Academic, 2018, Calendar, Academic calendar 2017 2018

		

	

	
				
					

		
			Agriculture and Natural Resources FACT SHEET

			www.tnstate.edu
			An Outreach Education Program Serving Limited Resource Individuals, Families and Communities Agriculture and Natural Resources FACT SHEET College of Agriculture, Human and Natural ANR-8

			   Fact, Agriculture, Resource, Natural, Agriculture and natural resources fact

		

	


                
                
	
				
					

		
			DEFINING CITIZENSHIP AND CIVIC ENGAGEMENT

			www.tnstate.edu
			involvement. In constructing a working definition of civic responsibility for this guide, we chose to depict it as an overarching concept that encompasses civic engagement and what it means to be a
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			COPYRIGHT 2001, GRAPHIC SYSTEMS, INC.;ALL RIGHTS RESERVED PAGE 1 OF 13 Facility Condition Assessment Practices Eric Teicholz, Alan Edgar ABSTRACT Facility Condition Assessment (FCA) is emerging as a powerful executive tool for …
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			© D.J.Dunn www.freestudy.co.uk 1 UNIT 61: ENGINEERING THERMODYNAMICS Unit code: D/601/1410 QCF level: 5 Credit value: 15 OUTCOME 4 STEAM AND GAS TURBINE POWER PLANT
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			Information document (ID) on Risks from Sewage Sludge Drying Plants . INTRODUCTION . 1 This guidance is issued by the Health and Safety Executive.
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